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If you need assistance, our Graphics Team would 
be happy to help you during the design process. 
Please contact the Graphics Department at The 
Great Gazebo with any questions regarding our 
Artwork Requirements or Product Templates.

EMAIL » graphics@greatgazebo.com
PHONE » 800.962.2767 or 517.625.2011
office hours » mon-fri 9am-5pm est 
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2244 W BRITTON RD • P.O. BOX 299 • MORRICE, MI 48857
800-962-2767 • 517-625-2011 • FAX:  517-625-2015

Thank you for choosing the Great Gazebo! We offer professional graphic design services for all of our products. Our 
graphics team can provide a free first layout, which includes basic logo placement, color scheme and any minor changes 
after the first layout. Additional changes may incur design fees. Our team can also offer more elaborate designs at an 
hourly rate of $60/hour. Please follow the below steps to help our designers achieve the best results for your product.

checklist —
Step 1 » Send us any elements you would like to use in your design. This may include logos, images, slogans, text, fonts, etc. (please 
see the “Understanding Types of Graphcis” section below for detailed information on what types of elements can be used). Small �les 
can be emailed to your sales associate (10MB or less) or you can upload larger �les to our dropbox (go to greatgazebo.com and click 
“upload” in the menu at the top right of the page. Follow the upload instructions).
Step 2 » Explain to us how you would like the elements arranged and what color scheme you would like to use in your design.
Step 3 » Our graphics team will verify that any elements you have sent can be used and are of the recommended quality. A layout of 
your requested design will be prepared.
Step 4 » Your sales associate will send you a proof showing the proposed layout for your approval.
Step 5 » Review your layout and determine whether any changes are to be made to your design (changes may result in an extended 
production time and/or additional design fees).
Step 6 » Once the desired design has been achieved, you will be asked to approve the artwork by signing and sending the layout back 
to us via fax or email.
Step 7 » After we receive your approval, your artwork will be moved into the production stage. Please note that any changes to the 
artwork after approval may result in order delays, a non-discountable $100 fee and the cost of any materials that have already been 
produced at that time.

understanding types of graphics —
vector »
When submitting logos, symbols, and other elements (excluding photographs), Vector formats are preferred as they provide the best 
quality and allow for resizing without loss of sharpness or detail. Most logos are created using Vector illustration software such as Adobe 
Illustrator. If someone created your logo or symbol, ask them to provide you with a Vector version (this type of �le may appear as “YourLo-
go.ai” or “YourLogo.eps”. You may not be able to view this �le without the proper application). If text is used in your Vector art, it must 
be converted to outlines before submission (ask your designer to do this for you). If you are unable to provide a Vector logo, a new version 
may need to be created before moving forward. You can have this commisioned independently or by our graphics team at a $60/hour 
rate.
digital imagery »
Raster-based images, such as photographs, can be used in your artwork, but image quality must be considred. Raster images, unlike 
vector artwork, may lose detail when scaled resulting in a blurry or poor quality print. As our products have large graphic areas and are 
viewed up close, using images of the proper quality is an important factor in achieving a good print. Most digital images from an 8 
megapixel camera (when captured at the highest settings) or higher can be used. However, composition, lighting, clarity and other factors 
can poorly effect images from even the highest quality cameras. It is best to provide the highest-resolution image avaialbe, as images 
can be decreased in resolution, but not increased without loss of quality. Our graphics team can determine if the images you have provid-

ed will result in a clear and quality print. 
image resources »
If you would like to use images in your design, you can provide your own images or �nd stock images from online resources such as 
istockphoto.com, shutterstock.com, unsplash.com, etc. Websites like these offer professional photographs at a variety of qualities 
and prices. If you would like to use an image from a resource such as these, our graphics team can help you select the size/resolu-
tion best suited for your project. Our staff can also handle the purchase (if necessary) and download of any image(s) for you (the 
image cost will then be added to the purchase price of your product, if applicable).
licensing & Permissions »
When submitting an image(s) it is important that you have permission or licensing rights to use those �les in your design. Some 
images may be free to use in personal projects, but are not autorized for commercial use without the consent of the image owner or 
licensing rights. Please verify that you either 1) own the copyright to any and all images submitted to the Great Gazebo or 2) you 
are fully licensed by the copyright owner to use any and all image(s) in your Great Gazebo artwork.
accepted formats »
Accepted raster image formats include JPEG, Photoshop (PSD or PSB, Adobe CC or earlier), TIFF, PDF, PNG, and BMP. We cannot 
use images that are within a word processing document such as Microsoft Word, PowerPoint, or equivelant.

text »
If you would like to use text in your design and have a prefered font(s), please provide the font name, or in the case that we don’t have 
the font already, the installation �le(s). Due to incompatability issues with some font types, we can only accept OpenType Fonts (.otf). 
Text can also be sent as a vector object by converting live type to outlines (in Adobe Illustrator, select Type > Create Outlines).
colors »
If you would like to use speci�c colors in your design, you will need to provide us with one of the following: 1) a CMYK breakdown of the 
color(s). For example, C=95 M=70 Y=30 K=25. 2) a Pantone+ Solid Coated color swatch. For example Pantone 485 C. 3) A swatch of 
the color(s) you would like us to use. For example, if you would like to use the color of an object, mail it to us and we will closely match 
the color(s) to a Pantone swatch. 
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If you need assistance, our Graphics Team would 
be happy to help you during the design process. 
Please contact the Graphics Department at The 
Great Gazebo with any questions regarding our 
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office hours » mon-fri 9am-5pm est 
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Thank you for choosing the Great Gazebo! We offer professional graphic design services for all of our products. Our 
graphics team can provide a free first layout, which includes basic logo placement, color scheme and any minor changes 
after the first layout. Additional changes may incur design fees. Our team can also offer more elaborate designs at an 
hourly rate of $60/hour. Please follow the below steps to help our designers achieve the best results for your product.

checklist —
Step 1 » Send us any elements you would like to use in your design. This may include logos, images, slogans, text, fonts, etc. (please 
see the “Understanding Types of Graphcis” section below for detailed information on what types of elements can be used). Small �les 
can be emailed to your sales associate (10MB or less) or you can upload larger �les to our dropbox (go to greatgazebo.com and click 
“upload” in the menu at the top right of the page. Follow the upload instructions).
Step 2 » Explain to us how you would like the elements arranged and what color scheme you would like to use in your design.
Step 3 » Our graphics team will verify that any elements you have sent can be used and are of the recommended quality. A layout of 
your requested design will be prepared.
Step 4 » Your sales associate will send you a proof showing the proposed layout for your approval.
Step 5 » Review your layout and determine whether any changes are to be made to your design (changes may result in an extended 
production time and/or additional design fees).
Step 6 » Once the desired design has been achieved, you will be asked to approve the artwork by signing and sending the layout back 
to us via fax or email.
Step 7 » After we receive your approval, your artwork will be moved into the production stage. Please note that any changes to the 
artwork after approval may result in order delays, a non-discountable $100 fee and the cost of any materials that have already been 
produced at that time.

understanding types of graphics —
vector »
When submitting logos, symbols, and other elements (excluding photographs), Vector formats are preferred as they provide the best 
quality and allow for resizing without loss of sharpness or detail. Most logos are created using Vector illustration software such as Adobe 
Illustrator. If someone created your logo or symbol, ask them to provide you with a Vector version (this type of �le may appear as “YourLo-
go.ai” or “YourLogo.eps”. You may not be able to view this �le without the proper application). If text is used in your Vector art, it must 
be converted to outlines before submission (ask your designer to do this for you). If you are unable to provide a Vector logo, a new version 
may need to be created before moving forward. You can have this commisioned independently or by our graphics team at a $60/hour 
rate.
digital imagery »
Raster-based images, such as photographs, can be used in your artwork, but image quality must be considred. Raster images, unlike 
vector artwork, may lose detail when scaled resulting in a blurry or poor quality print. As our products have large graphic areas and are 
viewed up close, using images of the proper quality is an important factor in achieving a good print. Most digital images from an 8 
megapixel camera (when captured at the highest settings) or higher can be used. However, composition, lighting, clarity and other factors 
can poorly effect images from even the highest quality cameras. It is best to provide the highest-resolution image avaialbe, as images 
can be decreased in resolution, but not increased without loss of quality. Our graphics team can determine if the images you have provid-

ed will result in a clear and quality print. 
image resources »
If you would like to use images in your design, you can provide your own images or �nd stock images from online resources such as 
istockphoto.com, shutterstock.com, unsplash.com, etc. Websites like these offer professional photographs at a variety of qualities 
and prices. If you would like to use an image from a resource such as these, our graphics team can help you select the size/resolu-
tion best suited for your project. Our staff can also handle the purchase (if necessary) and download of any image(s) for you (the 
image cost will then be added to the purchase price of your product, if applicable).
licensing & Permissions »
When submitting an image(s) it is important that you have permission or licensing rights to use those �les in your design. Some 
images may be free to use in personal projects, but are not autorized for commercial use without the consent of the image owner or 
licensing rights. Please verify that you either 1) own the copyright to any and all images submitted to the Great Gazebo or 2) you 
are fully licensed by the copyright owner to use any and all image(s) in your Great Gazebo artwork.
accepted formats »
Accepted raster image formats include JPEG, Photoshop (PSD or PSB, Adobe CC or earlier), TIFF, PDF, PNG, and BMP. We cannot 
use images that are within a word processing document such as Microsoft Word, PowerPoint, or equivelant.

text »
If you would like to use text in your design and have a prefered font(s), please provide the font name, or in the case that we don’t have 
the font already, the installation �le(s). Due to incompatability issues with some font types, we can only accept OpenType Fonts (.otf). 
Text can also be sent as a vector object by converting live type to outlines (in Adobe Illustrator, select Type > Create Outlines).
colors »
If you would like to use speci�c colors in your design, you will need to provide us with one of the following: 1) a CMYK breakdown of the 
color(s). For example, C=95 M=70 Y=30 K=25. 2) a Pantone+ Solid Coated color swatch. For example Pantone 485 C. 3) A swatch of 
the color(s) you would like us to use. For example, if you would like to use the color of an object, mail it to us and we will closely match 
the color(s) to a Pantone swatch. 
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If you need assistance, our Graphics Team would 
be happy to help you during the design process. 
Please contact the Graphics Department at The 
Great Gazebo with any questions regarding our 
Artwork Requirements or Product Templates.

EMAIL » graphics@greatgazebo.com
PHONE » 800.962.2767 or 517.625.2011
office hours » mon-fri 9am-5pm est 
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artwork requirements » design your own

Thank you for choosing the Great Gazebo! We encourage professional graphic designers to create artwork for any of our 
products. All of our media is digitally printed and liquid laminated to add durabilty, shine, and UV protection. Please 
follow the below instructions on how to properly perpare your artwork for submission. Failure to meet our artwork 
requirements may create delays in your order. Use our ��������������� on 
����� before submission to avoid setbacks.

artwork Templates —
Create your own artwork for any of our products using our Adobe Illustrator templates. Each set of product templates provides speci�c 
instructions for properly preparing your design. Please visit our website, greatgazebo.com, where all templates are available to download. 
Navigate to the corresponding product page (example: Products » Baby Gazebo) where you will �nd the template download area at the 
bottom right side. Please note that most of our products have multiple artwork templates. If you have used an artwork template in the 
past and are doing so again, please make sure that you are using the most up-to-date templates before proceeding. You can also contact 
us if you would like templates emailed to you directly.

color settings —
Color format »
All of our products are printed using the CMYK process. All artwork is to be submitted in the CMYK color format using CMYK colors. If 
using raster images, �rst set-up in the CMYK format before placing into the Illustrator templates. Using other color formats may produce 
undisired results. For the best and darkest blacks, we recommend using the CMYK value, C20 M20 Y20 K100.
pantone »
Our printer is closely calibrated to the Pantone+ Solid Coated color chart. If your branding has speci�c color guidelines, please provide 
the Pantone+ Solid Coated chart value(s), or provide the color(s) to us as a CMYK breakdown (Example: C10 M50 Y40 K15). A valid 
Pantone+ Solid Coated name must be provided (Example: Pantone XXX C). If not, the color will be produced in the CMYK equivelant 
which can render undesired results. Gradients created with Pantone colors are known ro reproduce undesired restults, therefore CMYK 
colors are recommended. Please note that we are unable to reproduce metallic colors.
samples »
If color accuracy is a concern, a pre-production print sample can be sent to you for approval at a $50 cost. Contact your sales assotiate 
to request a sample. Please note that print samples may extend your production timeline and may not be available on rush orders.

image quality & resolution —
Our products have large graphic areas and are viewed up close, therefore, we want to help our clients achieve the hightest print quality 
possible. We recommend using Vector artwork when available and high-quality raster images for the best results.
vector »
Vector art is preferred. It provides the best quality and allows images to be resized without loss of sharpness or detail. If text is used in 
your vector art, it must be converted to outlines before submission (See “Text & Fonts” on page 4 for additional information).
raster »
When selecting raster images, keep in mind that our products have large graphic areas, sometimes as large as 50 inches tall (refer to 
our artwork templates for the speci�c dimensions of the product you are designing). Because of the nature of our products, visitors will 
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be very close to the graphics, so image quality is a factor. Be sure to select images that can be used on a large scale without losing quali-
ty. All photos or raster images must be 100 DPI at 100% scale. Our Adobe Illustrator templates are supplied at 10% scale, therefore, 
images can be prepared at the equivelant 1000 DPI at the 10% size. Please do not submit images above 100 DPI (at 100% scale) as 
this will create unecessarily large �les and you may be asked to resubmit your artwork.
licensing & Permissions »
When using either vector or raster content, please verify that you either 1) own the copyright to any and all images submitted to the Great 
Gazebo or 2) you are fully licensed by the copyright owner to use any and all image(s) within your Great Gazebo artwork.

text & fonts —
All text, including that within vector images, such as logos, should be sent with fonts as outlines or with a font folder included. Due to 
incompatability issues with some font types, we can only accept OpenType Fonts (.otf).

linked/placed images —
When adding linked or placed �les (images, logos, etc) to your Adobe Illustrator document, those �les must be embedded or included in 
a separate folder for submission. If this step is not completed, we will not be able to open your artwork and it will need to be resubmitted. 
To embed all linked images, choose File » Save As, choose a �le name and location to save your document and then select Save. In the 
following dialog box, titled “Illustrator Options”, check the box to “Include Linked Files” and then select “Ok”. Alternately, you can 
include all linked images in a separate folder named “Linked Images” to be submitted along with your artwork �le(s).

accepted file formats —
The Great Gazebo prefers Adobe Illustrator (Ai) �les (Illustrator CC or earlier), but also accepts Photoshop (PSD or PSB) �les (Photo-
shop CC or earlier), EPS, TIFF and Print-Quality PDF �les prepared to the speci�cations detailed above. Files can be sent using ZIP 
compression, but we do not accept �les that have been compressed using the Stuf�t format.

submitting your artwork —
Before submitting your artwork, complete the Quick Checklist on page 5 to verify you have met all of our artwork requirements. Files 
under 10MB can be emailed to your sales associate or to graphics@greatgazebo.com. Files larger than 10MB can be uploaded via our 
website, greatgazebo.com. At the top right of the webpage, click “Upload”. You will be redirected to our Hightail dropbox. Choose Select 
Recipients » The Great Gazebo and then follow the directions to upload your �le(s). Please include your organizations name in the �le 
or folder name and any special instructions in your email or in the message box on Hightail. For alternative ways to submit your artwork, 
please contact your sales associate.

artwork layout & approval —
Once your artwork has been submitted it will be assesed for image quality and that all guidelines were met. Our graphics team will then 
prepare an artwork layout for your approval. This layout will be a visual representation of your submitted design and identify the colors 
used in your artwork. Once you or someone from your organization approves the layout, your artwork will be moved into production.

Please note that all artwork submitted to the Great Gazebo for production must meet these requirements. Our delivery schedule may 
depend on the quality of the artwork submitted and upon any changes made to the artwork once the order has been worked on.
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Thank you for choosing the Great Gazebo! We encourage professional graphic designers to create artwork for any of our 
products. All of our media is digitally printed and liquid laminated to add durabilty, shine, and UV protection. Please 
follow the below instructions on how to properly perpare your artwork for submission. Failure to meet our artwork 
requirements may create delays in your order. Use our ��������������� on 
����� before submission to avoid setbacks.

artwork Templates —
Create your own artwork for any of our products using our Adobe Illustrator templates. Each set of product templates provides speci�c 
instructions for properly preparing your design. Please visit our website, greatgazebo.com, where all templates are available to download. 
Navigate to the corresponding product page (example: Products » Baby Gazebo) where you will �nd the template download area at the 
bottom right side. Please note that most of our products have multiple artwork templates. If you have used an artwork template in the 
past and are doing so again, please make sure that you are using the most up-to-date templates before proceeding. You can also contact 
us if you would like templates emailed to you directly.

color settings —
Color format »
All of our products are printed using the CMYK process. All artwork is to be submitted in the CMYK color format using CMYK colors. If 
using raster images, �rst set-up in the CMYK format before placing into the Illustrator templates. Using other color formats may produce 
undisired results. For the best and darkest blacks, we recommend using the CMYK value, C20 M20 Y20 K100.
pantone »
Our printer is closely calibrated to the Pantone+ Solid Coated color chart. If your branding has speci�c color guidelines, please provide 
the Pantone+ Solid Coated chart value(s), or provide the color(s) to us as a CMYK breakdown (Example: C10 M50 Y40 K15). A valid 
Pantone+ Solid Coated name must be provided (Example: Pantone XXX C). If not, the color will be produced in the CMYK equivelant 
which can render undesired results. Gradients created with Pantone colors are known ro reproduce undesired restults, therefore CMYK 
colors are recommended. Please note that we are unable to reproduce metallic colors.
samples »
If color accuracy is a concern, a pre-production print sample can be sent to you for approval at a $50 cost. Contact your sales assotiate 
to request a sample. Please note that print samples may extend your production timeline and may not be available on rush orders.

image quality & resolution —
Our products have large graphic areas and are viewed up close, therefore, we want to help our clients achieve the hightest print quality 
possible. We recommend using Vector artwork when available and high-quality raster images for the best results.
vector »
Vector art is preferred. It provides the best quality and allows images to be resized without loss of sharpness or detail. If text is used in 
your vector art, it must be converted to outlines before submission (See “Text & Fonts” on page 4 for additional information).
raster »
When selecting raster images, keep in mind that our products have large graphic areas, sometimes as large as 50 inches tall (refer to 
our artwork templates for the speci�c dimensions of the product you are designing). Because of the nature of our products, visitors will 

page 4

artwork requirements » design your own (continued)

be very close to the graphics, so image quality is a factor. Be sure to select images that can be used on a large scale without losing quali-
ty. All photos or raster images must be 100 DPI at 100% scale. Our Adobe Illustrator templates are supplied at 10% scale, therefore, 
images can be prepared at the equivelant 1000 DPI at the 10% size. Please do not submit images above 100 DPI (at 100% scale) as 
this will create unecessarily large �les and you may be asked to resubmit your artwork.
licensing & Permissions »
When using either vector or raster content, please verify that you either 1) own the copyright to any and all images submitted to the Great 
Gazebo or 2) you are fully licensed by the copyright owner to use any and all image(s) within your Great Gazebo artwork.

text & fonts —
All text, including that within vector images, such as logos, should be sent with fonts as outlines or with a font folder included. Due to 
incompatability issues with some font types, we can only accept OpenType Fonts (.otf).

linked/placed images —
When adding linked or placed �les (images, logos, etc) to your Adobe Illustrator document, those �les must be embedded or included in 
a separate folder for submission. If this step is not completed, we will not be able to open your artwork and it will need to be resubmitted. 
To embed all linked images, choose File » Save As, choose a �le name and location to save your document and then select Save. In the 
following dialog box, titled “Illustrator Options”, check the box to “Include Linked Files” and then select “Ok”. Alternately, you can 
include all linked images in a separate folder named “Linked Images” to be submitted along with your artwork �le(s).

accepted file formats —
The Great Gazebo prefers Adobe Illustrator (Ai) �les (Illustrator CC or earlier), but also accepts Photoshop (PSD or PSB) �les (Photo-
shop CC or earlier), EPS, TIFF and Print-Quality PDF �les prepared to the speci�cations detailed above. Files can be sent using ZIP 
compression, but we do not accept �les that have been compressed using the Stuf�t format.

submitting your artwork —
Before submitting your artwork, complete the Quick Checklist on page 5 to verify you have met all of our artwork requirements. Files 
under 10MB can be emailed to your sales associate or to graphics@greatgazebo.com. Files larger than 10MB can be uploaded via our 
website, greatgazebo.com. At the top right of the webpage, click “Upload”. You will be redirected to our Hightail dropbox. Choose Select 
Recipients » The Great Gazebo and then follow the directions to upload your �le(s). Please include your organizations name in the �le 
or folder name and any special instructions in your email or in the message box on Hightail. For alternative ways to submit your artwork, 
please contact your sales associate.

artwork layout & approval —
Once your artwork has been submitted it will be assesed for image quality and that all guidelines were met. Our graphics team will then 
prepare an artwork layout for your approval. This layout will be a visual representation of your submitted design and identify the colors 
used in your artwork. Once you or someone from your organization approves the layout, your artwork will be moved into production.

Please note that all artwork submitted to the Great Gazebo for production must meet these requirements. Our delivery schedule may 
depend on the quality of the artwork submitted and upon any changes made to the artwork once the order has been worked on.
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design services —
The design process explained. Here you will 
find  what will be needed from you when 
our graphics team creates your artwork.

DESIGN services (continued) —
The design process explained. Here you will 
find  what will be needed from you when 
our graphics team creates your artwork.

DESIGN YOUR OWN —
Instructions on how to design your own 
artwork using our product templates.

DESIGN YOUR OWN (continued) —
Instructions on how to design your own 
artwork using our product templates.

quick checklist —
Complete our checklist to verify that your 
artwork has been properly prepared to our 
requirements before submission.

I have used the latest Artwork Templates available from 
greatgazebo.com

I have used the CMYK color format & have specified any 
Pantone+ Solid Coated colors

I have used vector artwork and/or have prepared any 
raster images at 100dpi at 100% scale (or the equivalent 
1000dpi at 1000% scale)

I have sent text and vector images, such as logos, with 
fonts as outlines or with a font folder included (open-
typle fonts only)

I have embedded all Linked/Placed images into my file(s) 
or included in a separate folder with all links

Files are Submitted as AI (cc or earlier), PSD/psb (cc or 
earlier), EPS, TIFF, or Print-Quality PDF

quick checklist
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